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Introduction

This document is an addendum to the course material you have received for a class in using System Architect to work with the DOI Enterprise Architect Repository.  The instructor will be guiding you through each of the tasks; this addendum is intended to provide some printed material in lieu of actual course material.  In the near future, you should be getting a complete set of course material, and can discard these notes.

Each user will follow the same set of instructions to create diagrams, add symbols, and develop definitions.  Object names must be unique in an encyclopedia; therefore, all objects created should be prefixed by the user initials.  For example, if the instructions tell you to create a diagram called “Wild Fire Management”, you would name the diagram “XXX-Wild Fire Management” or “XX-Wild Fire Management”, where XXX = your initials.

Task Set 1. -- Logon to Citrix MetaFrame XP Presentation Server
and launch Popkin Software’s System Architect application

1. Use IE or Netscape and enter the address http://psa.nbc.gov/psa/
2. Click on Popkin Login.
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http://psa.nbc.gov/psa/

3. Enter the User name and Password you were issued for the NBC servers into  the Log On to Windows dialog.

4. Make sure the Log on to: is INBCDENTX
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5. Click on “OK” once you have read this warning.
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6. If the ICA Client File Security dialog is displayed, toggle on the Full Access and Never ask me again for any application radio buttons, as in the picture below.
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7. If you receive any other messages from the server, read them and click “OK”.

8. Once Popkin Software’s System Architect starts up the first time or after a system reset, an Audit ID dialog is displayed, into which you enter your ID.  Normally the Audit ID, the first 7 letters of you NBC Server logon, is automatically completed for you. If the field is blank, please enter those letters.  

Click on OK.
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Task Set 2. -- Connect to a SQL Server encyclopedia

9. After you have closed the Audit ID screen or as soon as System Architect starts, you will be presented with a dialog that looks like the picture below:
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10. Switch to the “Existing” tab as illustrated below, and click on the browse button [image: image7.png]


 to the right of the New or Existing UDL File text box.
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For this test, you will be using a System Architect encyclopedia created specifically for the test, named Test_Base_Ency.  All the UDLs are stored on the mounted U drive.  Select Test_Base_Ency.UDL and click on Open.
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11. The Open Project dialog should look like the picture below.
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Open Encyclopedia (Project) dialog

12. Click on Open.

13. The System Architect window will display the DOI Framework, which completely fills the System Architect window aside from the space taken by the Browser, and the “Tip of the Day” dialog.

14. Click on the Close button in the Tip of the Day dialog.
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15. If the Browse toolbar on the left side of the SA window is not open, as in Figure 1, below, click on the Browser icon, the third icon from the left on the Toolbar, to open it.
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This icon toggles the Browser on
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Figure 1 -- The DEAR Framework in the SA Window

Task Set 3. -- Open large diagram

16. From the Browser, click on the + sign next to the word Diagrams to open the Diagram tree.

17. Click on the + sign next to the word TECHNICAL-REFERENCE-MODEL to open the tree for that set of diagrams.

18. Right-mouse click on TRM DOI Overview, and select Open from the floating menu.

19. You will get a warning message, as pictured below.  Click on Yes.
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· In a network environment, only the first person can open the diagram in Read-Write mode.  Everyone else can open the diagram in Read Only mode.  If you get a message telling you the diagram is in use by [Audit ID of user], click on OK.

Notice that at the top of the SA window, directly after the name of the diagram, the words READ ONLY are included.
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Diagram in use message
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Top of System Architect window

The resulting screen should look like Figure 2, below.
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Figure 2 -- Zoom to a single object

20. Select the magnifying glass from the right side of the Toolbar.
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21. Move your cursor down to the lower left-hand side of the diagram.  Press the left mouse button down, and keep it down while you move the cursor towards the right-hand corner, taking in a section of the diagram, as pictured below.
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Using the magnifying glass to select an area to enlarge

22. Release the left mouse button.  That section of the diagram has been enlarged.

23. Click with the left mouse button again.  Because the mouse is still a magnifying glass, the image enlarges again.

24. Continue to click until you can easily read the names of the objects on your monitor.

25. To return your cursor to the usual cursor shape of an arrow-head, hit the Escape key or click on the magnifying glass on the Toolbar again.
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Task Set 4. -- View object properties

26. Use the binoculars on the Toolbar.  


Enter the letter D in the text box.  From the list, select the TECHNICAL-SERVICE-CATEGORY symbol, Database-Storage.

Click on the Find button.
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Enter the letter ‘d’ in the text box
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Select the TECHNICAL-SERVICE-CATEGORY Database-Storage

27. Database-Storage on the diagram will then be surrounded by little black boxes, indicating that it is selected.

If you can, right-mouse click on the selected object and select Edit from the floating menu.

or select TECHNICAL-SERVICE-CATEGORY from the Edit menu as pictured in Figure 3.
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Figure 3
28. Click on each tab in the definition dialog in turn.  Click on Cancel.

If you get a “Do you want to save” message, click on No.

29. Use the binoculars on the Toolbar.  In the list on the window that comes up, find the object named Change Control [TECHNICAL-SERVICE-STANDARD].

30. Open the definition dialog by clicking on it with the right-mouse button and selecting Edit from the floating menu, or by selecting TECHNICAL-SERVICE-STANDARD from the Edit menu.

· The next two instructions can only be done if you are not in Read Only mode.

31. Change the name to XXX-Change Control, where XXX = your initials.

32. In the text box labeled Description, type

”Now is the time for all good men to come to the aid of their country.”

Click on OK.

33. Close the diagram by going to the FILES menu and selecting Close Diagram, or by holding down the CTRL+W keys.

Task Set 5. -- Perform a "referenced by" query

34. Expand the Definitions portion of the Browser by clicking on the + next to Definitions in the Browse window.

35. Expand the TECHNICAL-SERVICE-AREA
36. Select the definition named Component Framework.

Click on the definition name with the right mouse button and select Referenced by from the floating menu.
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The Referenced by window

37. Right mouse click on Business-Logic in the Referenced by window, and select Referenced by
38. Right mouse click on the first item in the SERVICE-COMPONENT/TECH-SVC-STD list, and select Open Item.

[image: image24.png]1)) SYSTEM_
5] TECHNICAL REFERENCE MODEL
=) TECHNICAL SERVICE-AREA

[E]) TECHNICAL-SERVI!
] TECHNICAL SERVI!
[E]) TECHNICAL SERVI!

@] TECHNOLOGY-DON —
@] TECHNOLOGY-DON T ——
[CI]SERVICE-COMPONENT/TECH-SVC-STD)

) USER MATRIX
) USER-COMMUNITY

PREE




39. Close the definition dialog by clicking on Cancel.

Task Set 6. -- Create a new diagram

40. Select Tools | Preferences from the top-most menu.  Make sure all the options are toggled as in the picture below.  

Make sure you check the Save box in the bottom right.  

Click on OK to close the dialog.
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Tools | Preferences dialog

41. From File on the main menu, select New Diagram.

42. Select BUSINESS-REFERENCE-MODEL and click on OK.
43. Name it XXX-Wild Fire Management, where XXX = your initials.  Click on OK.
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Naming a new diagram

· A new draw toolbar will appear.  Every diagram type has its own draw toolbar; this one is specifically for Business Reference Model diagrams.  

It has four icons specific to this diagram type, named BUSINESS-REFERENCE-MODEL, BUSINESS-AREA, LINE-OF-BUSINESS, and FUNCTION-ACTIVITY.  
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BRM diagram draw toolbar

· A blank diagram will open up.  Diagram drawing space is completely white; if no diagram is open, that space is gray or black.

To place a symbol on the diagram, all you have to do is click on the symbol in this draw toolbar, and then click on the diagram where you want the symbol to be placed.  If you’re drawing one of the four node symbols from the toolbar, so long as you hold the left mouse button down, you can move the cursor over the diagram until you find the place where you want to drop the symbol.

44. Add a BUSINESS-AREA to the diagram.

Name it XXX-Manage Wildfires 

Click on OK.

· So long as your cursor looks like a fountain pen with a small square to the right, you are in draw mode.  Every time you click on the diagram you add another symbol.  If you accidentally draw an unintended symbol, hit the Escape key.  

If you hit the Escape key or the arrowhead symbol, the cursor will become an arrow-head, so to continue drawing you will have to select the symbol you want to draw from the Draw toolbar.

· To add LINE-OF-BUSINESS and FUNCTION-ACTIVITY symbols to the diagram, hold the left mouse button down, and slowly move the cursor until there is a dotted line from XXX-Manage Wildfires to the new LINE-OF-BUSINESS and a black cross is on that line.  Making sure the new LINE-OF-BUSINESS is under XXX-Manage Wildfires, release the mouse button.
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Connecting a lower-level LINE-OF-BUSINESS

Add a LINE-OF-BUSINESS to the diagram, fastening it to XXX-Manage Wildfires.   Name it XXX-Provide Infrastructure 
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45. Add three FUNCTION-ACTIVITY symbols to the diagram, fastened to the LINE-OF-BUSINESS, naming them 
XXX-Educate Personnel
XXX-Assess Wildfire Threat
XXX-Review Lessons Learned
46. Add a Doc Block and place it on the lower-left hand portion of the diagram.  (The Doc Block is the symbol on the far right of the draw toolbar.)
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The Doc Block

47. Right mouse click on white space in the diagram and click on Save Diagram in the floating menu.

48. Save the diagram a second time using File | Diagram Save-As.  

Name the new diagram XXX-Wild Fire Management-ToBe and select Business Reference Model Diagram as the type.
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New Diagram dialog (also displayed when you choose Diagram | Save As)

49. Inspect the browser – are all your diagrams listed under Diagrams | BUSINESS-REFERENCE-MODEL?  If not, click on F5 to refresh the browser.

If you still do not see the diagrams, please ask the Instructor for help.

50. Close all the diagrams.

Task Set 7 – Create a new encyclopedia

51. On the main menu, select File | Open Encyclopedia
52. Click on the New tab in the Open Project dialog.
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Complete this dialog to create a new SA encyclopedia

53. Use the browse button to open a New UDL File dialog.  

Open the folder on the U: drive named User UDLs.

Enter the UDL name XXX-ENCY1, where XXX = your initials, and click on Open.
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54. Click on the drop-down arrow and select the name of your server.

For this task, the server name is IBCDENPSADB.

55. Enter XXX-ENCY1 for the Encyclopedia name.

Click on Open.

See Figure 4 , below.
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Figure 4 -- The completed Open Project dialog

56. Make the Property Configuration dialog look like the picture below.

Click on OK.

[image: image35.png]System Architect Property Configuration i

‘Applychanges o curtent encyclopedia

T~ Apply changes to allfuture encyclopedias

- Dataodeling - Dbject Modeling [~Target Databases
7 Eniiy Relaon and Physical | | [~ UL
I IDEF1 and Physical I our o500
dBise
- Business Modeling - Frameworks: INFORMIX
I~ Entrpise Architecture I~ DoDAF (C4SR) e e
I~ BPHN I T068F Mictosot Access
ORACLE
™ Brocess Char and Map 0672
% IDEFD and IDEF3 XML Design Parados
Progiess
I~ Simaion I ML Schema Proo
(- Stuchned AID |~ Dther useul dograms | Target Languagels)
™ Gane/Sarson ™ Sereen Painter
T~ Ward/Melor W Flow Chat e
I~ Yourdon/DeMarco ¥ Decomgosition
T~ S5ADM VB Round Trip
I
ooy | corcel | Reswre Heb | Advanced





SA Property Configuration dialog

57. A new encyclopedia will open.

· You can access this same dialog from Tools | Customize Method Support | Encyclopedia Configuration.

Task Set 8 – Extract from and merge to an encyclopedia

58. Select Tools | Merge.

[image: image36.png]Tools Dictionary Reparts

Code Synchranization

. »
4L Interface »
1 merutites »

0B Schems Generation
DB Reverss Engineering

Merge,
Exract,

lobal Change »





Tools | Merge

59. Click on the Browse button to select the source encyclopedia.
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Select the source encyclopedia

60. Click the Existing tab on the top of the window.

61. Make sure the Encyclopedia Type is SA Professional.

Select the DOI_TEST_ENCY.UDL, and click on Open.
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Open the source encyclopedia

62. If the ICA Client File Security dialog is displayed, toggle on the Full Access and Never ask me again for any application radio buttons, as in the picture below.
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63. In the Merge/Extract dialog, click on New List 
64. Select T:\LST Files as the target directory, and name the file, XXX_ORG_HIER (where XXX = your initials) in the Action Item File dialog.

Click on Save.
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the Action Item File dialog

65. In the Select Action Items window, select 

Target: Diagrams -> Symbols -> Definitions and Child Diagrams.


Type: ORGANIZATIONAL-HIERARCHY.

Select DOI Organizational Chart

Make sure Subordinate definitions is toggled on

Click on the Build button.
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66. In the Merge/Extract dialog box, in the If items are identical list box, select Always replace target.

Click on OK.
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Answer Yes to the message asking if you have backed up XX-ENCY1.UDL

67. The report displayed after the objects are merged tells you the effects on your new encyclopedia.  Close it by clicking on the X in the upper right-hand corner.
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68. Open the Browser and expand “Diagrams” and “Definitions” to look for the added diagram and definitions.  (Remember you may have to press F5 to refresh the Browser display.)

Task Set 9 – Create a new diagram, and copy and paste objects from one diagram to another

69. Expand “Diagrams” in the Browse window.

70. Right mouse click on ORGANIZATIONAL-HIERARCHY in the Browser.

71. Select New.

72. Name the new ORGANIZATIONAL-HIERARCHY Diagram XXX-My Org Chart and click OK.
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73. Tile the 2 diagrams (Main menu, select Window | Tile Horizontally)
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74. Select and copy a portion of DOI Organization Chart.

Hold the left mouse button down and drag the mouse towards the lower right – the dotted line is creating a “fence” to enclose symbols.  When you have selected a number of symbols (more than 5 and less than the entire diagram), release the mouse.
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The dotted line surrounds all symbols to be copied

75. Click on the Copy icon on the Toolbar -- the sixth icon from the left.


[image: image47].

76. Put your cursor into XXX-My Org Chart
· Click once to select it

· Click on the Paste icon on the Toolbar, to paste these symbols into the diagram..  (The Paste icon is to the right of the Copy icon; it looks like a clipboard with a sheet of paper on it.)

· When you see the hand icon on the diagram, click the mouse once.

· Depending on what you selected from DOI Organization Chart, you may get a warning indicating that you have selected a portion of the hierarchy.  Click on OK.
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The hand symbol is “holding” the copied symbols

Using the “Organization” box from the Draw Toolbar, add these additional Organization symbols to XXX-My-Org-Chart, changing the XXX preface of the name to your initials:

XXX-ABC
XXX-DEF
XXX-GHI
XXX-JKL
XXX-MNO
Adding these symbols is done exactly like adding symbols in Task Set 9 on page 28, above.  Your final diagram should look something like the picture below.
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XX-My Org Chart – the blue symbols (yours may be a different color) were copied from DOI Organization Chart; the white ones were added

77. Save your diagram.

Task Set 10 – Rearrange the children in a hierarchical model

78. Select File | Open encyclopedia.

Click on the Recent tab, and select the Test_Base_Ency

Click on Open.

79. Open the BUSINESS-REFERENCE-MODEL named Business Reference Model v2.

· If your test encyclopedia does not have this diagram, select the first BUSINESS-REFERENCE-MODEL diagram on the list.

80. Select each Sub Function in turn (e.g., Services for Citizens is a sub-function), and click on it with the right mouse button.  From the floating menu, select Arrange Children Vertically.

When you’re done, the diagram should look like the picture in Figure 5, below.

81. Save the diagram and close it.
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Figure 5 -- Portion of Business Reference Model v2 arranged vertically

Task Set 11 – Check-out and check-in an encyclopedia object

82. If the Browser is not open, click on the browser icon on the Toolbar to open it.

83. Open the Definitions tree, by clicking on the( + ) plus sign.

Open the BUSINESS-AREA tree.

84. Right-mouse click on Financial  Vehicles.

Select Access Control from the floating menu.
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· You may get a message that “The object is checked out by [name of somebody].  If so, please select a different definition in the BUSINESS-AREA list.
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85. Leave the action permitted as Check out.

86. Toggle the Subordinate definitions check box on and click on OK.

87. Click on the X in the upper right-hand corner of the report to close it.

Right mouse click on Financial Vehicles (or whichever definition you checked out) again,

select Access Control.

You will notice that the activity allowed this time is Check in.

88. Toggle on the check box for Subordinate definitions, and

click on OK.

89. Close the report.

Task Set 12 – Generate a report

	90. Select the Report Generator... option from the Reports        menu, or click on the Report generator button on the Main Toolbar.
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91. When the Reports window opens, select File | Open Report File.
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Reports dialogue – File | Open Report File

92. The report file to be used for this test is in the directory R:\Report Scripts\

Select DEAR1.rpt and click on Open.

· There are two kinds of reports pre-defined in this file.  One kind, whose name begins with Rpt-01-htm, generates output to the internet, and can be viewed through your internet browser.  The second kind, whose name begins with Rpt-01-txt, generates text reports, which can be read on-line or directed to a printer.

93. Select the report at the top of the list, Rpt-01-htm-enhanced-TRM Indented List - With Description, and click on the Generate button.
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Reports in the DEAR1.rpt file

94. When the report has been generated, an IE or Netscape browser window will open on your screen.  The output should look something like the picture below.
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Generated report for the web

95. Click on some of the “hot spots” in the column labeled “Technical Service Area.”.  Close the window.

96. Select the report named Rpt-01-txt- TRM Indented List - With Description, and click on the Draft button.  The output comes up in a Notepad-like screen.  Scroll through the report and close it by clicking on the X in the upper right-hand corner.

97. Close the Reports window.

Task Set 13 – Generate a report for the web (HTML)

Select the HTML Reports... option from the Reports menu.  There are five tabs on the HTML dialog.  Follow the instructions below for the settings you need for this task.

The General tab:
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98. Leave the “Template Home Page” as default

99. Click on Browse to the right of “Publish Home Page” and create a new folder named “XXX-HTML Reports” within the “R:\Report Outputs” folder.  This new folder will be used to store your HTML reports.
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· If you do not have Write access to this directory, please notify the Instructor immediately.

The Diagrams tab:

100. Click on the upward-pointing double arrow head to move all diagram names to the “Source List” list box.  

101. Select BUSINESS-REFERENCE-MODEL as the Type
102. Click on the Search button.
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HTML Generation – the Diagrams tab

103. Click on the downward-pointing double arrow head to move the diagrams to the “Diagrams for generation” list box.

The Advanced tab:

104. Make sure the High Speed check box is toggled off.

105. The Temporary Directory must exist, and you must have Write access to it.

If necessary, use Windows Explorer to make sure that directory exists.  If it does not exist, create a directory, and type its name in the Temporary Directory text box.

106. Select SVG (scalable vector graphic) for the Diagram files.
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HTML Generation – the Advanced tab

The Preferences tab

107. Toggle the check boxes as pictured below.
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HTML Generation – the Preferences tab

108. Click on Publish.
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109. Ensure that the directory listed is correct

click on OK.

· When you produce HTML output in a production environment, you must determine whether prior HTML output should be saved or can be over-written.

Task Set 14 – Work with a matrix

110. From the View menu, select Matrix Browser.  

111. Click on the DOI Matrices tab on the “Matrix Browser Panel”.
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112. Select Function-Activity to Sub-System
113. Click on Next in the Specify Filters window.
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Specify filters for Matrix

114. Click on Finish in the Choose Matrix Contents window.
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Choose Matrix Contents

115. Scroll down the displayed matrix output until you find some cells with X’s.
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The matrix output – notice the X’s

116. Click with your right mouse button on a row whose intersection with a column has an X.  

Select Modify Row Definition.  

Click on the Matrices tab.  The name of the column intersecting with the row should be displayed in the Sub-system combo box.

Click on the Cancel button to return to the matrix.

117. Select Matrix | Save As

Select R:\Report Outputs as the target directory, 

save the matrix contents as an HTML file named XX-BRM Tier to Sub-System.
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Save the matrix as an HTM file

118. Select Matrix | Exit to close the Matrix Browser.

Task Set 15 -- Generate an Excel spreadsheet using a VB macro

[This task may not be included in the Deployment Test]

Task Set 16 -- Generate a Word document using a VB macro

[This task may not be included in the Deployment Test]

Task Set 17a – Export data to a CSV file.

119. Select Dictionary | Export Definitions... 

120. In the Path text box, use the Browse button to select C$ on ‘Client’ (V:) (or whichever drive is marked as ‘Client’ on your machine.  Select the tmp directory.  If there is no tmp directory, create it.

121. Enter the name of the output file as XXX_Business_Area.CSV.  The output file will be written to your local machine.

[image: image68.png]File pame|

Files of b

32 Lmon TbcderpsadbiDats' (L)
‘32 Macios on Thcdenpsadb\Data' (M)
32 Repots on Thedenpsadb\Data' ]
3 D8 on Clent (5)
32 Trensferon tbcdenpsadbiDate 1)
32 Uds on TbcdenpsadbAData' ()
2

&mp
€ My Network Places

& v

S « @ ok E-
s
) @ o ompuer Comrect
Wome
a €) LA

ation Pubisher Instaler V1
Testing
NTERPRISE-MODEL-V1-4-5/





122. Select BUSINESS-AREA from the Definition text box, as pictured in Figure 6, below.
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Figure 6 -- Exporting dictionary definitions to a CSV file

123. Click on OK.

124. When the extract finishes, a report is displayed.
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125. Close the report.

126. Open the output CSV file in Excel.

127. Change the names of the individual definitions, so they are prefaced with your initials.
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128. Save the file and close it.  Make sure that it remains a CSV file with the same name!

Task Set 17b – Import definitions from a file into the SA encyclopedia

· On production encyclopedias, be sure to take a backup of the encyclopedia prior to running the Import command.  For this test of Citrix, however, we will not do the backup.

129. Select Dictionary | Import Definitions…

130. Use the browse button next to the Path text box to find the 
XXX_Business_Area.CSV file.

Select BUSINESS-AREA as the Definition type.

Leave Collision options set to Never replace existing definition.

131. Click on OK.
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132. The report should look something like the picture below.
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133. Close the report.

134. Find the new definitions in the Browser.
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